
Patterned Ground II: Creating Google Earth KMZ Files of Georeferenced Historic NIKE Missile Launch Site Aerial Photographs 
Using Global Mapper and the New Arc2Earth Extension for ArcMap

The NIKE missile was the �rst operational supersonic surface-to-air missile. The Nike Ajax and Hercules versions were 
all-weather weapons with a range of 30-90 miles to altitudes from 60,000 to greater than 100,000 feet. Nike sites 
consisted of an Integrated Fire Control facility (IFC) and a separate Launch Facility located relatively nearby. Between 
1954 to as late as 1979, operational Nike anti-aircraft missiles sites surrounded numerous cities and Defense Areas in 
the United States to protect them from attack by Soviet long-range bombers such as the Tupolev Tu-95 Bear. Site 
Summit in Alaska and site HM-40 in Florida were the last sites to close, closing in 1979.

Expanding the original Patterned Ground project that I began in 2013, Patterned Ground II adds georeferenced his-
torical aerial imagery to a new base map of the NIKE missile launch sites located around major urban centers and 
Defense Areas in the United States. I downloaded from the USGS EarthExplorer site historic aerial photographs from 

the 1950s, 1960s and 1970s showing operational sites. Metadata associated with these images provide lat/long coor-
dinates for the image corners, but georeferencing is di�cult when the corner marks are obscured in the scans and/or the imagery has been rotated 
such that the values do not re�ect the correct corner positions.

Using the new Arc2Earth extension for ArcGIS, Google Earth imagery can be loaded directly into ArcMap and used as a base map for visually georefer-
encing these historic images. The Arc2Earth imagery provides seamless, high resolution coverage eliminating the need to download individual recent 
orthoimages, as previously needed, to visually georeference a historic image. The Google Earth imagery allows for easy comparison between land 
use/land cover when the site was operational and the current land use/land cover of the same area.

In order create composite KMZ �les for use by the NIKE Historical Society and others, I needed to do additional processing. Raster data exported as 
KMZ �les directly from ArcMap do not display well in Google Earth. To improve the quality of the KMZ �le, I exported the georeferenced image �les 
from ArcMap as TIFFs, opened them in Global Mapper and exported them using Global Mapper’s KMZ export function, which creates a “super overlay” 
allowing Google Earth to display a quality raster image of the spatially located historic airphoto.
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The Nike Defense System

The NIKE defense system was de-
signed to replace World War II era 
anti-aircraft batteries, becoming 
operational in the mid to late 
1950s and remaining operational 
until the late 1970s.  The initial 
installations used the liquid fueled 
NIKE-AJAX missile. This was a two 
stage missile with a conventional 
high-explosive warhead and lim-
ited range. It was soon recognized 
that the NIKE-AJAX was inad-
equate for stopping the develop-
ing Soviet bomber threat and 
these missiles were replaced with 
the more powerful solid fueled 
two stage NIKE-HERCULES missile. 
These missiles had a longer range, 
could achieve a higher altitude 
and were capable of carrying a 
high explosive or nuclear warhead 
of varying yields.

A NIKE missile site con-
sisted of two operational 
sections, the Integrated 
Fire Control (IFC) and a 
launch area where the mis-
siles were stored and 
launched. The IFCs were 
not located far from the 
launch areas (minimum of 
1000 yards), were usually 
slightly elevated and had 
direct  “line of sight” con-
tact with the launch areas. 

The IFCs were rec-
ognizable by three 
large radar anten-
nas, an acquisition 
radar, a target track-
ing radar and a mis-
sile tracking radar. 

Nike Ajax (left) and Hercules (right) during test launches

This “dark” illustration in a booklet for Western Electric employ-
ees about the Nike-Ajax system (which they were assembling) 
hints at the somber mood during the Cold War years.

Although the Ajax missiles only carried conventional high ex-
plosive warheads, these missiles were soon replaced by the 
Nike-Hercules missiles that were capable of carrying nuclear 
warheads and had not only surface-to-air capability but some 
were modi�ed to be surface-to-surface capable as well.

From the same publication, this illustration of the 
Nike-Ajax and Hercules system shows all the major 
components of the system with the IFC and radars on 
the hill in the background, the launch area with the 
distinctive earthen berms around the fueling and war-
head placement area and the complex underground 
bunker system lying below the visible launch pads with 
the missile storage area and elevators to raise the mis-
siles to the launching rails. Each of these underground 
bunkers are 5,000 square feet in area.

Notice the city skyline on the horizon labeled as the 
“DEFENDED AREA”.

One of the �rst operational sites was in Lorton, Virginia. 
Construction began in March of 1954 and site was opera-
tional in 1955. Secretary of the Army, Charles C. Finucane, 
labeled it the “National NIKE Site” and hosted visits by 
foreign dignitaries and national and local politicians.

The target: 2008 photo of an RAF 
QRA (Quick Reaction Alert) Typhoon 
�ghter escorting a Russian Bear air-
craft over the North Atlantic. The 
TU-95 carried and dropped the 
AN602 Tsar Bomba (Царь-бомба) the 
most powerful nuclear weapon ever 
detonated. The test on October 30, 
1961 remains the most powerful arti-
�cial explosion in human history. The 
Atomic Energy Commission esti-
mated the yield at 50-60 megatons or 
1350 -1570 times the combined 
power of the bombs dropped on Hi-
roshima and Nagasaki.
(http://en.wikipedia.org/wiki/Tsar_Bomba)

Shape�le exported out of ArcMap as a KMZ and opened in Google 
Earth to examine the  sites with current high resolution imagery.

Google Earth screen shots of launch sites sur-
rounding New York City, Los Angeles and Detroit.

A number of websites including Wikipedia have listings for the nearly 300 locations of 
both the IFC and launch sites associated with the NIKE Defense System. I constructed a 
spreadsheet with coordinates for both the IFCs and associated launch sites, converting 
DMS to decimal degrees,  and importing the data into ArcGIS to visualize the locations 
throughout the United States. The distribution of the sites immediately explained 
Morgan & Berhow’s book title “Rings of Supersonic Steel”.

NIKE Launch Sites 
based on data from

 

http://en.wikipedia.org/wiki/List_of_Nike_missile_locations

The sites were built to protect “defense areas” which were major 
US cities and selected USAF Strategic Air Command bases. 

    Anchorage Defense Area, AK
    Barksdale Defense Area, LA
    Bergstrom AFB Defense Area, TX
    Boston Defense Area, MA
    Bridgeport Defense Area, CT
    Chicago-Gary Defense Area, IL-IN
    Cincinnati-Dayton Defense Area, OH-IN
    Cleveland Defense Area, OH
    Dallas-Fort Worth Defense Area, TX
    Detroit Defense Area, MI
    Dyess AFB Defense Area, TX
    Ellsworth AFB Defense Area, SD
    Fairbanks Defense Area, AK
    Fairchild AFB Defense Area, WA
    Hanford Defense Area, WA
    Hartford Defense Area. CT
    Homestead-Miami Defense Area, FL
    Kansas City Defense Area, KS-MO
    Lincoln AFB Defense Area, NE
    Loring AFB Defense Area, ME

    Los Angeles Defense Area, CA
    Milwaukee Defense Area, WI
    Minneapolis-St.Paul Defense Area, MN
    New York Defense Area, NY
    Niagara Falls-Bu�alo Defense Area, NY
    Norfolk Defense Area, VA
    Oahu Defense Area, HI
    O�utt AFB Defense Area, NE
    Philadelphia Defense Area, PA-NJ
    Pittsburgh Defense Area, PA
    Providence Defense Area, RI-MA
    Robbins AFB Defense Area, GA
    St. Louis Defense Area, MO
    San Francisco Defense Area, CA
    Schilling AFB Defense Area, KS
    Seattle Defense Area, WA
    Travis AFB Defense Area, CA
    Turner AFB Defense Area, GA
    Walker AFB Defense Area, NM
    Washington-Baltimore Defense Area, MD-VA

Mapping and Visualizing the NIKE Site Locations

http://m-epperson.home.comcast.net/~m-epperson/nike/

the 1950s, 1960s and 1970s showing operational sites. Metadata associated with these images provide lat/long coorhttp://nikemissile.org/

http://www.hmdb.org/marker.asp?marker=2092

http://lortonheritagesociety.org/docs/LortonHistory-NikeSite.pdf

Morgan& Berhow 2010

Morgan& Berhow 2010

Morgan& Berhow 2010

http://nikemissile.org/IFC/nike_hercules.shtmlhttp://nikemissile.org/Ajax.shtml

http://militaryhistorynow.com/2012/05/14/71/

Western Electric PDF

http://nikemissile.org/ (all three)

http://pruned.blogspot.com/2011/04/sunday-in-park-with-chicagos-cold-war.html

http://nikemissile.org/AJAX/PDFAJAX.pdf (both)

Previous work Creating Quality KML/KMZ Imagery from Historic Aerial Photographs

Downloaded imagery is opened in Photoshop. 
Imagery may come in any orientation with 
various levels of contrast and/or brightness

Downloaded imagery is rotated in Photoshop to match the appropriate orientation by 
comparing imagery with Google Earth view of the same area. In this case 90 degrees 
CCW rotation, but it may be 90 degrees CW, 180 degrees or none at all. 

In Photoshop a curves adjustment layer is added and curve is modi-
�ed to improve both brightness and contrast of the imagery. 

New ArcMap document is opened and Arc2Earth high resolution Google Earth 
imagery layer is added. Placemark coordinates are entered in the GoTo window 
and  pan to location (circled) is used to center the view on the correct location.

Unsharp masking is applied as needed. Multiple applications of “weak” unsharp 
masking  is needed for some images while others need only a single application or 
none at all.

Imagery is brought into the ArcMap document with a warning that it has no 
spatial reference. Using Fit to Display in the Georeferencing toolbar, the imag-
ery is displayed.

Typically three to four control points, linking the same point on both the aerial 
photo and the underlying Google Earth imagery,  can be used to accurately 
georeference an image. Images captured at an angle or areas with large eleva-
tion di�erences in the scene require more control points and may be impos-
sible to accurately georeference across the entire image.

Using the reveal tool in the E�ects toolbar, the georeferencing can be QCd on 
various scales to con�rm quality across the image.

Update Georeferencing on the Georeferencing toolbar is used to save a world 
�le associated with the aerial image. The exported raster is added as a new layer to the ArcMap document. Note the 

black border created to �t the rotated image in a square 2 meter x 2 meter/pixel 
raster. This layer must be removed from the ArcMap TOC before proceeding to 
the next step.

Global Mapper’s Raster Op-
tions cleanly removes the 
bounding black pixels by 
making them transparent,  
leaving the rotated and spa-
tially referenced image.

Exported KML opened in Google Earth. Image is spatially located, of 
high quality and shows the conditions around Nike site N-63 
(36.850683°, -76.479704°) on March 30th 1963. Using the transpar-
ency slider in Google Earth allows a comparison of land use/ land 
cover between 1963 image and current Google Earth imagery or use 
the time slider in conjunction with transparency to compare 1963 
image with other data sets layered in the Google Earth interface.

Coordinates for a speci�c placemark created in the initial Patterned Ground project are 
entered into the search �eld in Earth Explorer (earthexplorer.usgs.gov) with single 
frame aerial photos selected as the data set to search.

(D)

The Problem with Relief
Unlike modern orthoimagery which is processed to account for elevation dif-
ferences within the image, these air photos are simply “pictures” and the scale 
within an individual image varies depending on the di�erence in elevation 
between the aircraft and the ground surface at any given point.

* You cannot measure distances on an air photo, it is not a map

* An orthophoto has uniform scale, it is a photo map

* Because orthophotos have a uniform scale they can serve as a base

   map, and other map information can be overlain on it.   

* Dramatic elevation di�erences in a scene may make it impossible to

   georeference all parts of an air photo to the underlying orthophoto

   without severely distorting the air photo.

ArcMap’s georeferencing algorithms attempt to align control points that link locations 
between the non-georeferenced image and the underlying map or orthoimage.  Site 
LA-94 is located in the mountains north of the city of Los Angeles. This image contains 
the site in the mountains as well as low elevation valleys and �atlands. Dramatic di�er-
ences in scale occur within this image due to these elevation di�erences. ArcMap’s �rst 
order algorithm aligns the overall image, but close examination of control points show 
large error bars trying to connect points of similar locations. Second order algorithm 
attempts to minimize scale di�erences to attain a better match between points but 
distorts the image as it attempts to maintain scale across the whole image. 

At right is site Summit in the Chugach 
mountains, over 4000 feet above An-
chorage Alaska. In this case georefer-
encing only the critical portion of the 
image was the only approach to take 
and it still resulted in a very distorted 
image in Google Earth. The basic geo-
referencing for the site is good and the 

image drapes well on the 
Google Earth elevation 
data. Lowering transpar-
ency would show poor 
registration with features 
in the underlying imagery 
however.

Image at left has control points selected for a very narrow range of elevation resulting 
in an undistorted georeferenced image. Examining the quality of the georeferencing 
shows the area in the foothills is well matched to the underlying ortho imagery, but 
the urban area in the valley is poorly matched due to scale di�erences.

Image above shows the e�ect of adding control points in the low elevation urban 
area to the north of the foothills and updating the georeferencing. The image is 
stretched, changing the scale of the lower elevation area to more closely match the 
scale in the foothills portion of the image.

Because the elevation changes are gradual and consistent, changing from foothills to 
�at valley �oor, the image remains rectilinear but stretched along the upper border. 
Imagery, at right, shows the e�ect in a more complex setting of elevation di�erences.

Downloaded imagery is rotated in Photoshop to match the appropriate orientation by 

Global Mapper’s extensive export options include KML/KMZ with the creation of a “super overlay” which 
builds varying resolution layers resulting is a smooth display and zoom when opened in Google Earth.

Google Earth 
transparency slider

Google Earth 
time slider

Creating Red/Cyan Stereo Imagery from Historic Aerial Photographs

In some cases you can �nd adjacent images of the same scene to download from the EarthExplorer site. These can be used to create red/cyan anaglyphs to view in 3D.  Many ways to do this can be found online. This method is modi�ed from J. Caskey. 
(http://funnel.sfsu.edu/students/ballj/courses/G695/Making%20Anaglyphs2.12.pdf )

Test launch of NIKE Hercules missile 
from site Summit November 1961
Test launch of NIKE Hercules missile 

Each image copied to a layer in 
a new Photoshop �le

Original imagery downloaded 
from EarthExplorer site

Image brightness/contrast adjusted 
 Image > Adjustments > Brightness/Contrast
Unsharp masking applied
 Unsharp masking Filter > Sharpen > Unsharp Masking
Adjustments must be the same for both images

- label left and right layers
- move left layer to top
Lower transparency of top layer 
and position to align with 
common portion of lower layer

 Edit > Transform > Skew
Use skew tool to �ne tune align-
ment. Quality of alignment de-
pends on relief in the scene.

Due to radial distortion of the 
camera system you will not be able 
to get exact alignment throughout 
the scene regardless of relief.

Due to radial distortion of the 

Next, a few 
housekeeping 

steps

convert image 
mode to RGB

following mode change, 
Do not �atten image

add two new layers 
and �ll with cyan 

(R: 0, G: 255, B: 255)
select lower layer 
and invert color
Image > Adjust-
ments > Invert

reorder layers so 
cyan is above left 
image and red is 

above right image
Change blend mode of cyan and red layers to 

Screen and Merge Down cyan layer and left image 
and red layer and right image.

Change blend mode of merged 
cyan/left image to Multiply

add two new layers 

(R: 0, G: 255, B: 255)

Results: Visualizing History

N-36 (36.787500°, -76.129444°)  in the Norfolk Defense Area, is a good example of signi�cant land 
use change between 1963 and the 2013 Google Earth imagery. Top image shows the georefer-
enced 1963 air photo, middle image shows the 1963 air photo semi-transparent to show the cur-
rent land use. Bottom image shows the 1963 air photo with Google Earth roads layer added.

Chicago Defense Area showing the 20 NIKE launch sites surrounding the city.

Point (61.247778, -149.548333)
Located next to Anchorage airport, 
southwest of Elmendorf Air Force 
Base.

During the Cuban Missile Crisis in 
October 1962 crews at Alaskan NIKE 
sites (and those in Florida) were on 
“�ve minute status”  with missiles 
carrying nuclear warheads ready to 
�re in 5 minutes. Crews remained in 
this status for more than 30 days 
while President Kennedy dealt with 
the crisis. (Raichle, 2012)

All three of the Anchorage Defense 
Area sites, Bay, Point and Summit felt 
the impact of the 9.2 magnitude 
Good Friday earthquake on March 
27, 1964. Documentation from both 
Point and Summit highlight the fact 
that earth movement knocked nuclear missiles from their launchers and storage racks. The warheads were not 
armed, no radiation leaks occurred, but missiles had to be rendered safe, inspected and secured. (Raichle, 2012)

 at site Point
"We went inside the �rst launcher section of the �re unit on 'hot status' after prying open the blast doors. It was a big 
mess. No complete missile round was intact on the tracked launchers or handling rails. All the yoke structures had 
been sheared. The skins were gouged open; �ns bent in all directions. Solid propellants cracked and the rocket 
motor covers were o�. Strong stench from the exposed rocket propellant. Arming lanyards were pulled, energizing 
the on-board battery operated electrical power systems and gyros were spinning. Large components strung across 
the handling rails and launchers and on the �oor, in all directions. Each missile representing upwards of 5 tons of 
high explosive just waiting for the initial spark to set o� the entire lot... [After 40 years] I still have nightmares about 
what I saw in the �rst launcher section immediately after the earthquake." (http://nikealaska.org/aadcp/aadcp.html))
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Coordinates for a speci�c placemark created in the initial Patterned Ground project are Search results display as a list. Selecting an individual image foot-
print icon zooms the view to display the footprint for that image.

Selecting the next icon dispalys a low resolution image allowing  
you to check the quality of the imagery.

The fourth icon in opens a metadata �le for the image and the next 
icon with the green arrow opens the download dialog box (D).

Downloaded imagery is opened in Photoshop. 
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LA-94 ( 34.347392°, -118.408875°)  in the Los Angeles Defense Area. 1972 air photo viewed in perspective 
in Google Earth. Georeferencing is biased to the area around the launch site. The 90 meter per pixel SRTM 
elevation data used in Google Earth masks georeferencing errors created by the relief in the area. Insert 
photo shows three NIKE Hercules missiles raised at the launch site during a test in 1966. LA-94 was con-
structed in 1954, upgraded to support Hercules missiles in the late 1950’s and closed in 1968. LA-94 com-
plex is now Los Angeles County Fire Suppression Camp #9 housing both air attack and air rescue squads. 

Site PI-03, Pittsburgh PA Defense Area ( 40.598333°, -79.891944°)

Resample tool (Data Management > Raster > Raster Processing > Resample) is used to reduce the reso-
lution and �le size of the original raster. Raster is then exported with the spatial ref-
erence set to the data frame, which is de�ned by the Google Earth imagery, and the 
Use Renderer box checked to reduce the image to 8 bit further reducing the �le 
size to around 20 mb.

The exported raster opened in Global Mapper. Note the data is spatially located. 
Global Mapper has tools to automatically crop the black collar from the image. 
In addition there are tools to automatically crop collars from topo maps allow-
ing you to create seamless maps when your �eld location falls at the intersec-
tion of 2 or more quads.

http://m-epperson.home.comcast.net/~m-epperson/nike/

C-03 (41.938333, -87.634167)

Located on the western shore 
of Lake Michigan at Montrose 
Beach, now Lincoln Park Yacht 
Club.

"Chicago is loaded for bear - 
even the Russian bear if the 
Reds should ever dare send 
their bombers to attack the 
city." "A ring of sword-like 
guided missiles called the 
Nike - revealed for the �rst time today - stands ready to send sudden death belting into the sky to meet any 
enemy head on." "They are inescapable by any air maneuver now known to aviation…" "The thing you ought 
to remember is that the Nike's presence hereabouts should enable you to sleep a lot more soundly." "They 
make nice neighbors."
--Chicago American

(left)

(right)

(use red/cyan glasses to view processed images in 3D)

A small sample of a unique collection of data points across the country 
re�ecting history & land use/changes over the past 50+ years.

Raster images exported as KML/KMZ �les from ArcMap do not display well in Google Earth, presenting as coarsely pixelated versions as you zoom in. The method 
outlined below can be used to create KML/KMZ �les that display well in Google Earth. The starting raster can be anything from an air photo to a topographic or 
geologic map. Maps are easier because they do not require Photoshop adjustments and can be georeferenced using the coordinates in the collar marginalia.


